Reference

TDS7000 Series
Digital Phosphor Oscilloscopes

071-0880-00

RO OO
071088000



To Use the Front Panel

You can use the dedicated, front-panel knobs and buttons to do the most commonly performed operations.

Turn INTENSITY to adjust waveform intensity.

Push FastAcq to turn Fast Acquisition

on and off.
Push CURSORS to turn cursors on and off.

Push PRINT to make a hard copy.

Push DEFAULT SETUP to return settings to the

default values.

Push AUTOSET to quickly set the vertical,

~

horizontal, and trigger controls for a usable |
H INTENSITY
doplay. o) (RE) (o) ol (o
- C——HORIZONTAL — 1 ——TRIGGER——
l POSITION £ i
Use the multipurpose knobs to control —< R SOURGE GOUPLING  SLOPE [
parameters selected from the screen interface. -
Push a FINE button to make small changes with N\
a multipurpose knob. @ o -
- SAMPLES NOISE
~ @ <| SCALE [> MobE
LE\|EL
OUCH SCAEEN @ @ PUSH TC[SET 50%
Push to turn the touch screen on and off. > orr ) = = O @E
A \
Push ZOOM to add a magnified graticule to the
display. Push the HORIZ or VERT button to
select the axis that you want to magnify.
Use these knobs and buttons to set horizontal
SCALE and POSITION for the waveforms. Push
DELAY to turn on horizontal delay, and then use
POSITION to set the delay time. Adjust
RESOLUTION to change the number of acquired
points in the waveform.
Use these knobs and buttons to set the basic
trigger parameters. Push ADVANCED to display
a menu of additional trigger functions.
Use these buttons to start and stop
acquisition or start a single acquisition A
sequence. The ARM, READY, and TRIG'D ( VERTICAL
lights show the acquisition status. -
POSITION CH 1 POSITION CH 2 POSITION CH3 POSITION CH 4
Turn channel displays on and off, and adjust the —-< S S S S

channel POSITION and SCALE using dedicated
knobs and buttons.
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To Use the Screen Interface

You can control all oscilloscope functions except the power switch using only the screen interface.

Choose the Toolbar

Touch a button in the toolbar to display a —
control window at the bottom of the display.

to a multipurpose knob. Turn the multipurpose
knob to adjust the parameter value.

Or Choose the Menu Bar

Touch here to
change to menu-bar
operation.

v i s i = = B

Satnple

‘ 2 il

h
Chan 1

Display

File  Edt  Merical Haorizdscg Tig  Display  Cursors Measwe  Math Utiliies

Horlzontal/caquisition Setup

Use some menu items to
display a control window at the
bottom or side of the display.

Use some menu items to

M20.0ns 30
A Chl s

Delay Mode On
Fast Agguisitions Auto
Rl Mode Auto

directly change settings.

Equivalent Time Auto

) )  Autoset
N Fast Acquisitions
. o ; Bun/Stop...
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Help

Position/Scale.
Resalution.
Acquisiion Mods

Fast Fiame Setup...
Fast Frame Cankrols:

Zoom Setup.

chi  0.0m Y

More Operating Tips:

[y
Ch1 Position

Chl Scale

50.0mY

Touch here to change to

toolbar operation.

Touch here to close a

control window.

m  Use the touch screen to control the oscilloscope when bench space is
unavailable, such as on a cart or in an equipment rack.

®  Plug in a mouse and keyboard if you have the bench space to use them. You can
plug in a USB mouse or keyboard anytime, even while the oscilloscope is

running.

m  Use the menu bar to access PC-related functions, such as Page Setup, Export,

and Copy.



To Display a Waveform

Attach a probe to CH 1 and connect the probe 1
to your signal.
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Push CH 1 if channel 1 is not
already displayed.
P
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< VERTICAL
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Adjust VERTICAL and HORIZONTAL 4 - S S S S
POSITION and SCALE if necessary to SCALE SCALE SCALE SCALE
optimize the display. @ @ @ @
.
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Adjust RESOLUTION to change the record § 6

length and sample rate. You can acquire
more samples in the waveform to see more
detail or acquire fewer samples with a
faster update rate.

Adjust INTENSITY to change the
brightness, vector fill, and display
persistence of acquired points.

Recommended Probe
Accessories

P7240 Active Probes for
general-purpose applications

TCA-SMA, TCA-BNC 50€2, and TCA-N
adapters for your probes and cables

and low-noise applications



To See More Waveform Detail

Use Zoom Use the Zoom function to magnify an acquisition vertically, horizontally, or in both
waveform dimensions. SCALE or POSITION changes that you make to the Zoom
graticule affect only the display, not the actual waveform that is acquired.

ZOOM

Push the ZOOM button to split the {
screen and add a zoom graticule.

Push the HORIZ button or the VERT buttonto 9
select the axis you want to magnify in the zoom
graticule. Use the multipurpose knobs to adjust

scale and position of the magnified waveform.

Main graticule Zoom graticule

You can also set up a zoom graticule
from the screen interface. First touch and
drag across the segment of the waveform

that you want to see in greater detail.

Then select Zoom from the drop-down list to
magnify the highlighted waveform segment.

Use Horizontal De|ay Use horizontal DELAY to acquire waveform detail in a region that is separated from
the trigger location by a significant interval of time.

Trigger point
9gerP ‘<— Acquired waveform —>‘

AL

f«<——  Delaytime —— |
C—HORIZONTAL /™ E
PoSITIoN Xxpansion point
Push the front-panel DELAY button. 1 ——=(oe) P P
Adjust the delay time with the horizontal 2 —— RESOLUTION
POSITION control, or enter the delay time zo0m @
in the control window. Q) S
q SCALE D
Adjust the horizontal SCALE to acquire 3 ——
the detail you need around the delay

expansion point.

More Operating Tips:

= You can use Zoom and Horizontal Delay together to magnify a delayed
acquisition.

m  Toggle Horizontal Delay on and off to quickly compare signal details at two
different areas of interest, one near the trigger location and the other centered at
the delay time.



To Use Fast Acquisition

Turn Fast Acquisition on to acquire up to 400,000 waveforms per second.

Push the front-panel FastAcq button. {1 —

Or select Fast Acquisitions in the
Horiz/Acq menu.

Adjust INTENSITY to optimize the intensity or
color grading for the signal you want to analyze.
Increasing intensity can make less-frequently
acquired points brighter in the display.

INTENSITY

“TRIGGER—— f;

Honizécq  Trig  Display  Cur:

Horizontal/Acquisition Setup...

Zoom Contrals...

Autozet

i
5 RE:

Bun/Stop...

Delay Mode On

Fast Acquisitions ALto
v Foll Mode Auto
Equivalent Time Auta

<

FPosition/Scale. ..
Fiesolution. ..
Acguisition Mode...

FEast Frame Setup...
Fast Frame Contrals...

Zoom Setup...

File  Edit Vertical Horizdteg  Tig  Displap  Cueors heague  Math Utillies Help
Sample 1 1115010

How DPOs Work

Unlike DSOs that have long dead times between
acquisitions, Digital Phosphor Oscilloscopes
(DPOs) continuously acquire waveforms at rates
comparable to analog oscilloscopes. DPOs
continuously overlay the acquired information
into a three-dimensional database that is
updated on the display 30 times per second. For
each pixel in the display, the intensity (or color)
of the pixel is proportional to the number of
actual samples that the pixel represents.

Gh1 Scale

a00.0my

Chi  &00m ¥

Analog Real Time sweeps—»l | | | | | | | | | | | A | | | | | |
Digital Storage acquisitions—»l | A\ | |
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More Operating Tips:

m  Choose one of the color grading palettes in the Display Colors control window to
see different sample densities represented in different colors.

= Turn AutoBright on in the Display Appearance control window. When you use
AutoBright, the displayed waveforms remain visible even at low trigger repetition
rates.



To Choose an Acquisition Mode

Honizécq  Trig  Display  Cur:

Horizontal/Acquisition Setup... —> I
Zoom Contrals...
Autozet
Fast Acquizitions
Bun/Stop...
Select Acquisition Mode... in the 1 — Delay Mode On
HorizlAcq menu. Fast Acquisitions Auta

v Foll Mode Auto
v Equivalent Time Auta

Or touch the Horiz button, and then

select an acquisition mode in the Essfimit’Seat..

Fiesolution. ..

horizontal/acquisition control window.

FEast Frame Setup... ’ # of Wims
Fast Frame Contrals... 16
Zoom Setup...
For Average or Envelope acquisition modes, 2
touch the # of Wims control and then set the
number of waveforms with the multipurpose
knob. You can also double-touch the control
and use the pop-up keypad.
. ags L _ record duration Displayed record points (at
HOW the ACQUISItIOI‘I acquisition inigrval = number of points in record maximum horizontal magnification)
Modes Work B A N
Interval 1 2 3 4 Interval 1 2 3 4
I —e
Sample mode retains one sampled point from A7
each acquisition interval. —— 34— 11— o
Sample [~ T ¢ °
. f——x—* § i °
Peak Detect mode uses the highest and m
lowest of all the samples contained in two
consecutive acquisition intervals. Peak Detect | __ .
N J\L J N J\_

Hi Res mode calculates the average of all
the samples for each acquisition interval.

Hi Res L e— e

Three acquisitions from one source

A
4 A

Acquisition 1 2 3
Envelope mode finds highest and lowest record m

points over many acquisitions. Envelope uses
Peak Detect for each individual acquisition. Envelope

Average mode calculates the average value for
each record point over many acquisitions. m m m Average

Average uses Sample mode for each individual
acquisition.

.




To Select a Trigger

Select the EDGE trigger type and then set the ——

source, coupling, slope and mode with these
front-panel controls. Push ADVANCED to select
one of the other trigger types.

You can also select a trigger type in the

Or touch the Trig button and then selecta ——

IC——TRIGGER—D

Tig Display Cursors  Measue

Trigger menu.

trigger type in the trigger control window

Trigger Selections

that is displayed.

Trigger Type Source

Fattern Ch1 ¥ T

E L

Coupling / N Set 50%
et 50%

£ nD £ Event [Main) Trigger Setup.
EDGE [rovanced) uick Select R
Edgs Setup
SOURCE COUPLING ~ SLOPE I
icth et
Runt Setup
Timegut Setup...
Transition Setup..
- e
EXT Lagic Pattem...
MODE Logic State..
LEVEL R e y—
@ @& PUSH TOSET 80% B Event (Delayed) Trigger Setup...
Holdoft
® ® O
Run/Stop,
_- [ Tia | WEdue —+ dequirs

Edge Trigger

Slope Forced Trigger

— = |

Trigger type Levels Timers Trigger conditions
Edge Single level None Trigger on rising or falling edge, as defined by slope
/; control. Coupling choices are DC, AC, AC LF Reject, AC
_J HF Reject, and Noise Reject.
Glitch Single level One to specify glitch Trigger on glitches narrower than the specified width or
j_\l—.nf width ignore glitches narrower than the specified width.
Width Single level Two to specify minimum Trigger on pulses that have widths between the range of

and maximum pulse
widths

the two timers or outside the range of the two timers.

Runt Two levels to define the One to specify an Trigger on a pulse that enters the transition region from
logic transition region optional minimum one side but does not leave the region from the other side.
runt-pulse duration
Timeout Single level One to specify time-out Trigger when a signal does not make a transition for a
\’ time specified length of time.

Transition — Two levels to define the One to specify transition Trigger when a logic signal spends more time or less time
f v logic transition region time in the transition region than a specified amount of time.
LI

Setup/Hold =

Independent levels for
Data and Clock

One to specify setup
time and one to specify
hold time

Trigger on violations of setup or hold time between a Data
signal and a Clock signal. The specified setup and hold
times can be positive or negative values.

Pattern Independent levels for One to specify pattern Trigger when a Boolean combination of up to four
@ each channel duration channels becomes true. Trigger inmediately or only after
the combination is true for a specified time duration.
State Independent levels for None Trigger on transition of one channel when a Boolean
%] each channel combination of up to three other channels is true.




To Use A (Main) and B (Delayed) Triggers

You can use the A Event (Main) trigger alone or combine it with the B Event (Delayed) trigger to capture more complex signals.

Set the A trigger type and source in the 1

A Event (Main) tab of the trigger control
window.

Choose a function in the A—B Sequence tab of
the trigger control window.

Set the trigger delay time or the number 3

of B events, as appropriate.

Trigger on B Event

The A trigger arms the oscilloscope.
Posttrigger acquisition starts on nth B event.

B Trigger After Delay Time

The A trigger arms the oscilloscope.
Posttrigger acquisition starts on the first B
edge after the trigger delay time.

B Event Mode

Trigger Type
Fattern

A Event ! eq B Event Mode A Edge — Triguer After Time -~ B:Ewent — Acquire

A->B Sequence Horizontal A Event Ref Pt Position
a Only Delay Mode 50.0
—
I

R ) W | —

!
B Event B Trig Level
0.0
Trig After
Tiime I Trig Delay

Fupe 16.0ng

Source

Ch2 ¥

Pretrigger Posttrigger
record record
A trigger point |<— Acquired waveform record —-|
|
A trigger I |
source | |
I
B trigger _WMK_?\_NKKK
source . g | . .
Waiting for nth B trigger point
event (Where n=5)
A trigger point
| |
A oger SRR
source | ||
_NANNAN AN AN
B trigger —]
source Trigger
[~ . .
‘ delay time—.| B trigger point

More Operating Tips:

m  B-trigger delay time and horizontal delay time are independent functions. When
you establish a trigger condition using either the A trigger alone or the A and B
triggers together, you can also use horizontal delay to delay the acquisition by an
additional amount.

m When using the B trigger, the A trigger can be any of the following types: Edge,
Glitch, Width, or Timeout. The B trigger type is always Edge type.



To Take Measurements With Cursors

Push the front-panel CURSORS button. 1 Cursor Source

Select the waveform you want to measure and 2
a cursor type in the cursor control window.

Or you can activate cursors on the selected - Cursor Type
. ; C Mezas Math LIt i)
waveform directly in the Cursor menu. — 1 iis il

Lursor Contrals,.

w Cursors On ! Split
H-bars
M &=

Sefup Close

Paired

Cursor Pasition... Spli

Cursor Setup

Cursor Positions

Cursl1 Pos Curs? Pos

Place cursors with the multipurpose 3 145 s 48, 0ms
knobs or enter the cursor locations

numerically. Cursor 1 Source Cursor 2 Source

If you choose split cursors to take 4
measurements between waveforms,
select the source for each cursor. T a : T1: 356.4 ms

T2: 352.5 ms

AT: 3.92 ms

1/AT: 255 Hz

V1:5.120V

V2: 4.886 V

AV: 234 mV
\AVIAT: 59.7V/s

)

Read cursor measurement §
results in the display.

Other Cursor Measurement Tips:

®  You can set the cursors to move together in tandem if you choose the Tracking
cursor mode. The cursors move independently if you choose the Independent
cursor mode.

= If you use the zoom graticule, you can place a cursor directly on a specific
waveform point to take precision measurements.

= You can also move cursors by touching or clicking them and then dragging them
to a new position.



To Take Automated Measurements

Touch the Meas button, and then select up to ——
eight measurements using the measurement
control window.

Use the tabs to access measurements in
four different categories.

Or choose a measurement for the selected

Time

Arapl

Measurement Setup...

Snapghat...

Armplitude

Time »
tore 3
Dizplay Statistics 3

D mfmrmimmm | omam s

waveform directly in the Measure menu.

Gating...

Ch [hath

Measure  Math  Utiliies  Help

High Lewvel
Low Level
Amplitude
b aminiLin
rinirnLirn

Pz Overshoot !

Meq Overshoot

Riet

Measurements

Mean
Pk-Fk

Freq

Chi
ChA
Ch1

Rise Time |Chi

Dielay

Rise Time |Ch2

Setup

Display

whaveform Histograms. . tean
Reset Histogram BMS
Histogram Measurements  » Cycle Mean
Cucle RMS
Automated Measurement Selections
Amplitude Time More Histogram
n
T | o U | o | S | i | vy F Y IS
. Positive . o Burst Wfm
High Mean Overshoot Period Rise Time Delay Width Count Max De\ﬁgjtion
T o W R _:Lt'_ N A F. S
Negative ) osiive Hits in .
Low Pk-Pk Ovegrshoot Frequency | Fall Time Duty Cycle Phase Box Min uxlo
Max Amplitude RM Positive Negative Negative Area Peak Pk-Pk .
P S Width Width Duty Cycle Hits =20
Min M}gz:aﬁ %ﬁse Cycle Area Median Mean w30




To Customize an Automated Measurement

e ——— o A ‘/..w\.—
Use Gating to confine the measurement ———— > ° [
to a certain portion of the waveform. i

Turn on measurement statistics to
characterize the stability of the measurement.

High Ref e apshot on G
q0.n Period Frea:
Fos Widl Mea Width :
Burst Wid
. i Rise Time Fall Tim
Adjust the measurement reference levels to e [l o ore - Duty Coe
different relative or different fixed values. - i

Low :

Amplitude Pk-Pk :

(LR (A1 Mean Cycle Mean :

10 RMS Cycle RMS :
Al Cyc Are

Select snapshot to see a one-time
view of all valid measurements.

To Set Up a Histogram

Touch and drag across the segment of the { ———={_ \\ N
waveform that you want the histogram to cover. . :
To set up a horizontal histogram, for example, S D
make the box wider than it is tall. Bt

Cancel

Select Histogram from the drop-down 2
list.

Trg  Display  Cursors

View the histogram at the top or edge of
the graticule.

If you need to make any adjustments 4 Waveform Histogram
to the histogram, use the histogram Source Histogram - Histogram
setup control window. ch [k ot et

Take automated measurements on histogram § - Adjust
1 H : Histogra
data. See previous page for information.




To Use Math Waveforms

Math  Utilties  Help Mlath 1 Math 2 Math 3 Math 4

Select Math Setup in the Math menu. { — Math1 = Chi
Digplay OnsOK...
Pasiion/Scale Display
Label

Position

Chil -Ch2
Ch3 -Ch4
Chi ~ Ch2
Ch3 * Chd

Spectral Setup..,

Choose one of the predefined math equations. 2 e

Phaze 5 pectium
Spectral Contols...

Set Math Averages.

Equation Editar...

Or touch Editor to define a more advanced
math waveform. Then build the waveform
expression using sources, operators, constants,
measurements, and functions.

Tirne Freq

Loy 10
Operands

- Bl

Integral Sort

E

To Use Spectral Analysis

Choose Spectral Analysis to define FFT
magnitude and phase waveforms. When an Adiust FET cent
FFT waveform is selected, you can use the | ; Just P center
multipurpose knobs to adjust the FFT waveform L o requency
just as you would using a spectrum analyzer.
Res BW
Al ~—— Adjust FFT span
Ref Level

20.0dB

You can view time-domain and
frequency-domain waveforms
simultaneously. You can also use
gating to select only a portion of the
time-domain waveform for spectral
analysis.




To Store Information

To Save and Recall Waveforms

To save or recall waveforms, select 1 —

Reference Waveforms and then Save Wfm... or
Recall Wfm... in the File menu.

Or touch the Refs button.

Use the reference setup control window to copy
a live waveform into one of four nonvolatile
reference waveform storage locations. You can
also display these waveforms as reference
waveforms.

Select Save Wfm to File to store the live
waveform as a file on a disk drive. You can
recall a waveform stored on disk into one of the
internal reference waveform locations for
display.

To Save and Recall Instrument
Setups

To save an instrument setup, select
Instrument Setup in the File menu.

1 —

Or touch the Setups button.

File

Edit  Yerlical Haniz/fcn

i Etup. ..
Recal Defaul Setup

Run Application

Page Setup...

Tig Display Cu

Fisference Setup...
Diisplap On 0.
Position/Scals. .
Label.

Recall wfm.

I Refs I

o ath

Vert Scale

1.0%

Horiz Position

File  Edit  ‘“ertical

Relerence Wavefoms 3

Fecall Defaul Setup !g

Heorizdise

Run Application 3

Pane Setun

Save Wrm to Refl
1| Ref

Save Wim to File
oW
-

I Setups I

Use the settings control window to save the 2 —
current setup into one of ten internal storage
locations. Use the pop-up keyboard to label the
setups for easy identification.

Or select Save Settings to File to store the
current setup on a disk drive. You can recall any

Save Settings from Local Memory

+5 Check

Clock Jitter

Setup Time

setup stored on disk and then save it in an
internal setup storage location for quicker
access.

To restore the oscilloscope to a known initial state, 3 —
push the front-panel DEFAULT SETUP button.

Data Bus

DEFAULT
SETUP

“ rite Strobe

o
Factory

Factory

Fle  Edt

Vertical

n Factory
m Factony

Horizd&e

Befersnes W aveforms »

Fec

Or select Recall Default Setup in the File menu.

Instiument Setup.

efup

Fun &pplication

Pane Srtun

Recall Ref1 from File
e

s
Delete Wim File

@l [ [ete

FResall

Save Settings
to File




To Print a Hard Copy

Fil=  Edit  Vertical Herizifie

. Beference W aveformns 3

To print a hard copy to an attached SN IS
printer or a network printer, push Recall Default Setup
the front-panel PRINT button. =
Run Application 3

Or select Print in the File menu. If Page Setup..
necessary, you can make changes rink Prewiew

to the page orientation in the Page

Setup dialog box.

Fwnmrt Sehon

Palette

The Page Setup dialog box also includes —— Wiew Image
selectors for Sthe print pglette and a feature * Colar & Ful-Screen & Momal
called Ink Saver. Ink Saver optimizes the ~ :
display colors and shades for printing hard I GrayScale € Graticule{s] Orly || " Ink-saver Made
copies on white paper. ™ Black & White

To Export Your Resuits

Edit  Wertical Horizdden

Ctil+C

Trg  Display  Cure

Caopy

Full S creen [bitm ap)
Graticule [bitmap)
W aveform [data)

You can use the Windows clipboard to —
copy information. Simply select the item
to copy, copy it, and then paste it into
another Windows application.

Copy Setup. ..

Measurement [data)

ELX-3564 System Controller Test Report
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You can export waveform data into & ——— =0 eaasats, saiaaasia,

comma- Separated ACS” flle for use In a —-1479636700,-14572868851,-14638168722 ,-1529021630,
spreadsheet or data analysis program. Select -1520765593, 1541686902, - 1485577715, -1404424516,
Export Setup in the File menu to set the output ~1500133037, 1505702745, -1511133155, - 1516423702,
H —-1521573850,-1526583406,-1531451606,-15361768089,

content and format for images, waveforms, or -1540762450, -1545204233, -1549503037, - 1553 658465,
measurements. -1557670132,-1561557666, -15652 60711, 1565336922,
—-1572271966,-1575559526,-1578701302 ,-1581696998,
-1584546739, -1587248060, -1589004913, - 1592213 660,
-1504475079,-1612554845, - 1598555107, - 1600373340,

—1EM2Nd2480 _16E7TARATE 1 ANAOTR0%? _1ANS16306R




To Run Application Software

You can install and run optional application software on your oscilloscope. These software packages provide advanced capability
supporting many applications. Two examples are shown below; additional packages may be available. Contact your Tektronix

representative for more information.

Use TDSJIT2 Jitter Analysis Software to
characterize timing performance. Analyze jitter
on contiguous clock cycles using single-shot
acquisitions.

Software to measure disk drive signals
according to IDEMA standards.

Follow the instructions provided with the ——— I

application software to install it. To run
the software, select the application in the
File / Run Application menu.

<3 O D

D G )| €5 G G

M40.0ns 50634 00}
A Ch3 r106m ¥ H

Input: Main

Source
cht ¥

Mid

Analysis Plots

@ Measurements Inputs Results

Ref Levels

Autoset

C: High ®

ooocorv | ®  qoooooov | *
Hysteresis @ Low €

ooocorv | ®  -rcooooov |

Hoiiz4cq  Lig

Disploy  Cursors  Meagwe  Math  Uiliies  Help

M2000s 25654 © . 0.0s 1 400ps
4 Chi r 632m V.

Input Channels

Read Signal Sector Pulse

i v [ che w

Read Gate Index Pulse
ch2 v | chda ¥

File Edt Yertical

Beference Waveforms
Ingtrument Setup...
Recall Default Setup

Trigger

ode. Start Sector r
.

Preamble & StopSector #

1000000 us | 10 L

Horizddcg  Tng Display  Cursors

S

Page Setup...
Frint Previsw
Frint....

Chil+P

Ezpart Setup...
Selact for Export
Esport...

1 Fesent Setup Rl T

Mirimize

Shutdawn. ..
Exit

h



To Connect to a Network

Like any other Windows computer, you can

connect the oscilloscope to a network to enable S S
printing, file sharing, internet access, and other — =
communications functions. ! i /
Network

To make a network connection, consult with
your network administrator, and then use the
standard Windows utilities to configure the
oscilloscope for compatibility with your network.
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To Use a Dual Monitor

Connect a keyboard, mouse, and monitor to the
oscilloscope and configure Windows for
dual-monitor mode. You can operate the

oscilloscope while having full use of Windows
and other installed applications on the external
monitor.

Connect the monitor to the upper SVGA port on
the oscilloscope rear panel. Use the Settings

tab in the Windows Display Properties dialog

box to set up a dual-monitor configuration.




To Access the Help System

Help Topics[  Back Options <

25 LClose Minimize

Touch the HELP button or select Help on
Window in the Help menu to receive

Offset
Overview Y Display ¥ Position & Scale Y Offset N

U
LContents and Indesx. ..

context-sensitive help on the current setup. Festore Help

Tolse

Use the Verlical Offset cortrols to set the offsel value of the selected

waveforn ta shift the vertical aceuistian window to metch the wave

form ciata you vwant to aceire

Technicals Touch a channel tab at the top of the corfrol window Lo select the vertical input channel. Touch the
gchnical upport... offset control to map it to one of the muttipurpose knobs, and then use the knob to sef the offset

Customer Feedback... value

Speciications...

Behavior
About Scope. . Use the affset contral to eliminate clipping the wavetorm. The atfset contral affects the vertical
= acquisition window by subtracting & DC bias from the waveform. This moves the level at the vertical
center of the acquisition window of the selected channel. Visualize offset as scroling the
acuistion window towerds the top of & large signal for increased offset values and scroling

towards the battom for decreased offset values.
—- The oftset contral affects the display of the wavetorm by detining the channel reference indicator
to match the offset rather than the ground level. The offset affects only channel wavetonns as

compared to the position control that affects all waveforms, inclucing math and reference
waveforms

What do you want to do next?

J Continue to learn about the vertical setup controls.

Help Topics: TDS Phoenix 2]

Contents | Index | Find |

Click & topic, and then click Display. Or click another tab, such as Indss.

() Introducing the TDS7000 Series O sciloscope
[7] About the TDS7000

Select Contents and Index inthe Helpmenuto 1}
access any topic in the help system. Select the B Specitcatons

[2] Using the orline help

topic, and then touch the Display button in the .
i @ Front Panel
dlalog bOX' @ Screen Intetace
@ Howta ?
@ Open Desktop
@ Rea Parel
@ Reference Infomation

Disply | Piint Cancel

Help Topics BEGE Options i E Claze Minimize:

Vertical Setup Control Window

Ancess this cortrol window from the Yertical menu

Overview Display  Position & Scale Y Offset A

Control Window Overview

Use thess controls to setths vertical parameters for live (¢
each channel are indspendent, uss the tabs at the top of th
channel you want to change

For more information on & cortrol, touch one of the outined | vfertical Position & Scale A

Overien Y Display Y Pasition & Scale Offs | A

IN—_position & Scale
[= - i -
m-—“— Position r ToUse A j
-

|u-nmm n {| |

Help Topics: Back Options 4 > Claze Minimize:

Use the P|stion control to set the vertical postion of the w|aveform on
—— the scres|. Use the Scals control window to cortrol the virical scale
o the ws|retorm. Touch ths cortrols to map them to the m| tipurpose

knobs, an|l then uss the knobs to change the wavetorms

Ry (T b
-

Touch an outlined control shown in the help
window to receive more specific information
about the control.

Behaviol

Each wan|sform has ts own vertical posttion cortrol. The ontrol
incrsment|: or decrements the vertical posttion of the wav | form one
pixel at & |me. Increasing the postion value of the wavefc|m moves
the wavearm up, and decreasing the position maves the Jeaveform

! offsat Termination  Cc EEN
Display Each waveform slso has its own v|rtical scale cortrol. For a signsl with a constart
amplitude, increasing the scale caules the waveform to be displayed smaller, Decrasing the
" seale causes the wavelarmto be Jsplayed larger

For chann wavstorms, the scale | ing controls the verical size of the acquistiof window
as well as the display scale. The refige and resolution of the scale value depends cfi the
attached probes and on any other sternal factars you may have specified.

&
TP Use the dedicated knob on e frort panel to control the postion and scale cf the
oot i,

Touch a tab in a help window to navigate

between the Overview and specific topics. Vhat do you want 0 do next? R
KIS 1)

Touch the Minimize button in a help window

to move help out of the way so you can
operate the oscilloscope. Touch the Restore
Help button to see the last help topic again.




To Use the Oscilloscope 1/0

On the Front Panel (e )

—— Floppy disk drive accessible
from Windows

Probe compensator output to compensate

and deskew probes —J

Auxiliary input to provide an external
trigger input

Auxiliary output to provide trigger
output signal

Analog signal output from the CH 3 input

Channel inputs

On the Rear Panel

Removable hard disk drive to provide
individual environment for each user or to
secure data; press cover to release the disk

CDROM drive accessible from Windows,———

press cover to open the drive ==

USB connector for mouse, keyboard, or other. Tooo

peripherals

PS-2 connectors for mouse and keyboard

oo

0
oo

oo
oo

Upper SVGA port to connect a monitor for @ 60000, @
dual-monitor operation

Lower VGA port to replicate the oscilloscope display

0 0 00O
O 0 0 O G
00000

on an external monitor
Parallel port (Centronics) to—>@KO 60000000000 o]j@
connect printer or other device 0000009090099

GPIB port to connect to controller

RJ-45 connector to connect to network U

COMH1 serial port

External reference input and internal ___
reference output
Connectors for speaker and—»@ @
microphone
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